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New in This Release

This release supplement contains brief descriptions of new features, known

limitations, configuration and installation tips, and workarounds for this release of

the Solstice Backup™ software.

New Features

This release of the Solstice Backup software contains several new features and

improvements that are described in this section. For information about using the

new features, refer to the Solstice Backup 6.0 Administrator’s Guide and the Solstice
Backup 6.0 Installation Guide.

Indexing Enhancements

This release offers substantial architectural improvements to the earlier index

structures. The changes are mainly transparent in terms of user interaction, but the

benefits are significant.

Summary of Indexing Enhancement Benefits

Benefits of the indexing enhancements include:

■ Decreased conversion time when upgrading.

■ More efficient index cross-checking (for database integrity).

■ A more robust and stable database index structure that stores indexes more

efficiently.

■ Nondestructive index recovery.
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■ Significantly smaller client file indexes. The size of a client file index is greatly

reduced after conversion, even though the number of files it contains increases by

orders of magnitude. After conversion, the media database requires

approximately twice as much disk space as it did in Solstice Backup 5.x releases.

This expansion, however, is insignificant when weighed against the reduction in

size of the client file index.

■ Support for recovering the index to a specific time.

■ Improved availability of the nsrindexd program. Expect to see a decrease in

“server busy” messages.

■ Ability to perform backups after the media database has been converted, and

while the client file indexes are being converted.

New Client File Indexing and Media Database Disk Format

The Solstice Backup server maintains one file index for each client computer and one

media database that tracks data from all clients and save sets. Each time a backup is

completed, the Solstice Backup server creates entries for the backed-up files in the

client file index. The media database stores one entry for each save set and storage

volume during each backup operation.

This release of the Solstice Backup software requires that the client file index, server

index, and media database be converted to a new disk format. Because there is no

returning to previous Solstice Backup software releases once the client file index,

server index, and media database are converted, be sure to have an up-to-date

backup prior to converting them. The first time you run the new version of Solstice

Backup software, the indexes and media database are automatically converted. (The

Solstice Backup Release 4.2 and later client files indexes and media database are

automatically converted, but earlier releases must be recovered from backup.)

Save Set-Based Browse and Retention Policies

The Solstice Backup server uses browse and retention policies to manage the life

cycle of data and to control the size of the client file index automatically. The browse

policy determines how long files are maintained in the client file index on the

Solstice Backup server. The retention policy determines how long save sets are

maintained in the Solstice Backup server’s media database. Using Solstice Backup

software from this release, you can specify browse and retention policies for each

client, each save set, or for groups of save sets. This is a significant change that

allows greater browse and retention flexibility.

In earlier Solstice Backup releases, all save sets within a client had to have the same

browse and retention policy (because the policies were bound to the save sets at the

time nsrim ran). With this release of the Solstice Backup software, you can have

different browse and retention policies for each save set within a client (because the
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policies are bound to each save set when the data is saved). You can also change the

browse and retention policies of save sets at any time, without affecting the policies

of other save sets in the client.

Save Set ID Uniqueness across Solstice Backup Servers

Each client now has a unique ID that is used to identify it in the media database, and

for index backups to identify a save set with the client. The client ID is automatically

generated by the Solstice Backup server, is unique across servers, and is maintained

in the media database. For additional information, see “Querying the Media Database

from Earlier Solstice Backup Clients (LGTpa22115)” on page 31.

Solstice Backup NDMP

Network Data Management Protocol (NDMP) is a standards-based, storage

management client/server protocol for enterprise-wide backup of heterogeneous,

network-attached storage. NDMP enables the Solstice Backup 6.0or compatible

software releases to provide connections to computers with NDMP data modules for

tape operations, allowing a significant reduction in network traffic and better use of

the time window dedicated to backups. NDMP also allows the Solstice Backup

software to maintain the client index and media database, as well as control backup

operations on a computer with an NDMP service installed.

The Solaris 2.6, 7 (32- and 64-bit), and HP-UX 11.0 (32- and 64-bit) operating systems

support the Solstice Backup NDMP module. The Solstice Backup NDMP module is

not currently supported by Windows operating systems.

The following NDMP disk and tape services are supported by the Solstice Backup

NDMP module:

■ NetApp Filer

■ EMC Celerra

Supported feature sets include:

■ Full and level 1-9 differential backups for EMC and NetApp

■ Library sharing (without SmartMedia software)

Note – Customers wishing to use the NDMP feature must install Solstice Backup

6.0, Patch 1. To check for its availability, contact your Sun service representative.



10 Solstice Backup 6.0 Release Notes • November  2000

Directed Recoveries Using NDMP

Solstice Backup software with NDMP now supports directed recoveries that allow

you to recover backup data to a host other than the one used to back up the original

data. The operating system on the target host (<hostname>) must be the same as the

one used to back up the data.

For destructive recoveries, do one of the following:

■ Using the nwadmin GUI, set the mount point to:

Note – If you are using Data ONTAP™ 6.0, you must add a “/” after the mount

point.

■ Using nsrndmp_recover , enter the following command:

Note – In this command sequence, the host specified is the target host. If a host is

not specified, the target is the original application server. The <filesystem> variable

remains the previously defined filesystem.

For non-destructive recoveries, do one of the following:

■ Using the recover command, enter the following command:

■ Using the nwrecover GUI, enter in the Relocate field under Options>Relocate:

Note – In these command sequences, the host specified is the target host. If a host is

not specified, the target is the original application server. The <device> variable is the

name of the previously defined device.

<hostname>:: <filesystem>

nsrndmp_recover -m <hostname>:: <filesystem> -r

relocate <hostname>:: <device>

<hostname>:: <device>
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Snapshot Backup Support with NDMP

NetApp creates two types of filesystem snapshots—those taken at specified intervals

and those taken when a backup occurs. The snapshots taken during a backup are

automatically deleted when the backup is completed.

Solstice Backup release 6.0 and compatible versions support backing up and

recovering the snapshots that are taken at the specified intervals and that are stored

in the snapshot directory. For more information about snapshots, refer to the

NetApp documentation.

EMC and NDMP

If you are using the Solstice Backup Network Edition or the Solstice Backup Power

Edition, the Solstice Backup software with NDMP function supports EMC devices.

For additional information about NDMP features, refer to Chapter 12 of the Solstice
Backup 6.0 Administrator’s Guide.

Obtaining Information about NDMP Autochangers

Before you can configure an autochanger for NDMP operation, you must tell the

Solstice Backup server the NDMP autochanger handle and the pathname of the

media drive. Before setting up an autochanger or configuring the Solstice Backup

server for NDMP operation, enable NDMP support on the application server.

How to Find the Autochanger Handle and Pathname for EMC
Computers

The autochanger handle and device pathnames can be identified by issuing a list

command. To obtain the required information:

1. Halt the datamover:

Celerra> server_cpu EMC_hostname –halt now

2. Attach and power up the SCSI device.

3. Boot the server:

Celerra> server_cpu EMC_hostname –reboot now

4. Discover new devices:

Celerra> server_devconfig EMC_hostname –probe –scsi –nondisks
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5. Issue the list command (to get the handles and verify the information):

Celerra> server_devconfig EMC_hostname –list –scsi –nondisks

The procedure for obtaining the autochanger handle can also be completed through

a GUI in the browser.

To access the Administrator’s GUI:

1. In the browser window, enter EMC hostIP: 8000 .

2. At the prompt, enter your user name and password.

3. Follow the instructions that appear on the screen.

Configuring the NDMP Autochanger

Once you have found the autochanger handle and pathname, refer to Chapter 12 in

the Solstice Backup 6.0 Administrator’s Guide to complete the steps required to

configure the autochanger. Once you have created the ndmpjbconf_NDMPhostname
file, use the inquire command with Option 1, standard, specified as the

NDMP_type parameter value to search for available devices. You can then configure

those devices for NDMP operations.

Supported Backup Configurations

The Solstice Backup server with NDMP connection supports two configurations for

backing up data:

■ Local backup

■ Three-party backup

Local Backup

The local backup involves a tape device directly attached to the server where the

data resides. The data being backed up is sent directly from the NDMP server to its

attached autochanger. Configure the Solstice Backup server for NDMP operations as

you would for any NDMP backup.
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FIGURE 1 NDMP Local Configuration

Three-Party Backup

A three-party backup is completed using two NDMP servers. The data flows from

one NDMP server to another NDMP server and then to the autochanger that is

attached to the second NDMP server.

Caution – Three-party backups between an EMC NAS device and a NetApp server,

or between a NetApp NAS device and an EMC server, must be recovered to the

original device.

To perform a three-party backup:

1. Configure the servers as shown in FIGURE 2.

2. Install the Solstice Backup software on the server designated as your Solstice

Backup server.

3. You need not install any additional software on the NDMP servers.

4. Configure the Solstice Backup server:

a. In the Name field of the Client Resource, specify the hostname of the NDMP

server that contains the data to be backed up.

b. In the Storage Node field of the Client Resource, verify that the destination

server for the data being backed up is listed first.

L lC fi
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The client backs up the data to each NDMP server or storage node in the order

in which they appear in the attribute. If a successful backup cannot occur with

the first NDMP server in the list, the client selects the next server listed in the

Storage Node field.

For example, if the data you want to back up is located on a NetApp filer

called venus and you want to back up the data to another NetApp filer called

mars , you would list mars first and venus second in the Storage Node field.

Once the data is successfully backed up to mars , the backup is finished. If

there is a problem with mars , the data backs up to venus , since venus is the

next server listed in the Storage Node field.

c. Complete the rest of the Client Resource and configure the Solstice Backup

server as you would for any other NDMP backup.

For instructions on configuring your Solstice Backup server, refer to “Chapter 12:

NDMP Support for the Solstice Backup Server” in the Solstice Backup 6.0
Administrator’s Guide.

For instructions on performing a backup, refer to the Sun Solstice Backup
Administrator’s Guide.

FIGURE 2 demonstrates the data flow in a three-party configuration.
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FIGURE 2 NDMP Three-Party Configuration

Optimizing Qtree Backups with NetApp Data ONTAP 5.3.x

If you are using Data ONTAP 5.3.x and are backing up more than eight qtrees on one

volume, you might want to use the NDMP logical find option to speed up the

backup.

Caution – If you are running Data ONTAP 6.0 or later, do not use the logical find

option. The filer automatically selects the optimal backup method.

To enable the logical find option, enter the following command at the filer console’s

prompt:

filer> ndmpd logical_find
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When the option is enabled, the following message displays:

If the backup speed is not increased by enabling the logical find option, disable the

option. To disable the option, type the following at the filer console’s prompt:

When the option is disabled, the following message displays:

Note – If you reboot the filer, you must enable the logical find option again.

For more information regarding qtrees, refer to your Data ONTAP documentation.

NDMP Memory Requirements

Backing up large numbers of files using a Solstice Backup NDMP server can require

a large amount of memory and/or swap space. If the system does not have enough

swap space to hold the entire file history, you receive the following error message:

cannot decode the file

If this happens, try one of the following:

■ Increase the swap space. If, after increasing the swap space the backup is still

running slowly, try increasing the amount of memory on the system.

■ On HP-UX, consider modifying the maxdsiz parameter. For more information, see

“Modifying the maxdsiz Parameter in HP-UX to Accommodate Large Backups” on

page 34.

Installing an Autodetected NDMP SCSI Jukebox

When configuring an NDMP autochanger, you should install an autodetected

NDMP SCSI jukebox or an autodetected SCSI jukebox.

logical find set to: true

filer> ndmpd logical_find

logical find set to: false
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To determine which option to select:

■ If the jukebox is connected to an NDMP tape server and the robot is controlled by

the NDMP tape server, select the Autodetected NDMP SCSI Autochanger option.

■ If the Solstice Backup backup server or storage node controls the robot and shares

the autochanger with an NDMP tape server, select the Autodetected SCSI

Autochanger option. Configure the tape drives to be used by the NDMP tape

server.

NDMP Licensing Considerations

For performing NDMP backups and recoveries, both an NDMP client connection

and an NAS/SAN storage node enabler code must be applied to each NDMP client.

The NDMP feature has been packaged so that the client connection license and the

NAS/SAN license are bundled. Be sure to enter all the required enabler codes.

Warning Message with NetApp Recovery

If you are using Data ONTAP 6.0, you may receive an error message while

performing a recovery. The error message is similar to the following:

NDMP Service Log: RESTORE: WARNING: You are attempting to run
an extraction restore of a full backup image.

All files will be correctly restored.

If you intend to restore incremental backups, however,
subsequent restores of those images will not recreate the
file system as it appeared during the final incremental
backup.

NDMP Service Log: RESTORE: WARNING: Contact Network Appliance
technical support to set up a restore that will properly
handle incremental backups.

If you receive this message, contact Network Appliance technical support as directed

for additional information.

User Must Be Root for NDMP Backup/Recovery

In order to perform either a backup or recovery operation, the user must be logged

in as root. If the user is not root, the backup or recovery will fail.
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Backup and Recovery Support with NDMP (LGTpa22704)

In the current release, the NDMP feature of Solstice Backup supports backing up and

restoring data to Solaris or HP-UX clients only. Backing up and recovering data to a

Windows client is not supported.

No File Index for Multiple Mount Points on the Same Host
(LGTpa24557)

In this release, the Solstice Backup software does not distinguish between mount

points and normal directories when sending file history to nsrndmpix . For example,

if you back up a filesystem mounted on /mnt2/mnt3 and browse the file indexes for

the filesystem, all the indexes display correctly. If you then unmount /mnt2/mnt3
and later back up only /mnt2 , nwrecover and the recover command do not show

the directories under /mnt2/mnt3 . In order to see the indexes from /mnt2/mnt3 ,

you must browse the file indexes of the previously backed-up partition.

You can avoid this issue by backing up /mnt2 first and then backing up /mnt2/
mnt3 . When the backups are completed in this order, all the indexes display

correctly.

NDMP Backup Pools (LGTpa23888)

Recovery of an NDMP backup will fail if the volume is loaded in a non-NDMP

device. To prevent non-NDMP volumes from being recommended for NDMP

backups, create separate pools for NDMP and non-NDMP volumes.

NDMP File Recovery Limitations (LGTpa25216, 24935)

The following file-recovery problems exist in the current release:

■ LGTpa25216: For NDMP backups, recovering files from different save sets in a

“single recovery” session might fail if both of the save sets were backed up on the

same volume. When this occurs, the following message is displayed in the

Administrator window and generated in the daemon logs, along with a list of the

files that could not be recovered:

When doing a disaster recovery, perform a save set recover to avoid this problem.

Failed to open the tape device. Possible error:Restore requests
might be in conflict for the tape resource due to images from
different saves existing on the same tape. User is requested to
try just the failed request later. ABORTING...
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■ LGTpa24935: When performing a recovery while also using Data ONTAP 6.0, you

must specify a “/” at the end of the mount point. Otherwise, the recovery will

fail. When you specify a “/”, the recovery is successful. While performing the

recovery, you may receive an error message. For more information about this

error message, refer to “Warning Message with NetApp Recovery” on page 17.

Jukeboxes and Celerra Data Movers (LGTpa25122)

In an NDMP environment, you may only configure one jukebox device per Celerra

data mover. If you configure more than one, the jbconfig command finds only the

jukebox device with the lower target ID.

Support for Large Save Sets and Large Save Set

Names

This release of the Solstice Backup software supports save sets that are larger than 2

GB. This eliminates the need to divide large save sets into a series of smaller,

“continued” save sets from Solstice Backup 6.0 clients backing up to Solstice Backup

6.0 servers.

The maximum length limit on save set names has also been increased from 64 bytes

to 255 bytes. For upgrade considerations, see “Continued Save Sets Eliminated” on

page 26 and “Save Set Names Longer Than 64 Bytes” on page 26.

New Solstice Backup Data Format

This release of the Solstice Backup software uses an upgraded, 64-bit data format.

The new format was introduced to support several of the features that are new in the

6.x releases. They include:

■ Indexing and media database improvements

■ Support for Solstice Backup NDMP

■ Support for save sets that are larger than 2 GB

For upgrade considerations, see “Changes Resulting from the Improved Save Stream

File Format” on page 25.
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Cluster Environment Support

A cluster is two or more nodes that are connected and appear to network users as a

single, highly available system. A highly available system allows application

services to continue despite most hardware or software failures. It does this by

providing failover (relocation) capability. The Solstice Backup software supports

Sun™ Cluster 2.2.

Error Message Guide

The Legato Error Message Guide describes messages and troubleshooting procedures

for problems that you might encounter while using the Solstice Backup software.

The messages documented in the guide are those that are the most useful and most

frequently encountered. The Error Message Guide is available on the documentation

CD-ROM in your media kit.

Multi-Server Storage Node Sharing with

SmartMedia

If you manage storage media using the latest version of the Legato GEMS

SmartMedia software, this release of Solstice Backup software allows you to

configure multiple Solstice Backup servers to share a single storage node. The

requirements are as follows:

■ All volumes, drives, and autochangers on a shared node must be managed by

Legato GEMS SmartMedia software.

■ A Solstice Backup server that shares a node must have only Legato SmartMedia

devices defined on that node.

■ You must assign a unique name to each autochanger on a shared node; names are

not automatically assigned.

■ You must upgrade Solstice Backup servers to the current release before upgrading

the storage nodes.

See “Upgrading Storage Nodes” on page 28 for upgrade considerations.

To learn more about Legato GEMS SmartMedia availability and support, please

contact Legato Systems at sbu-sales@legato.com.
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Directed Cross-Platform Recovery

Directed cross-platform recovery allows you to recover backed-up data remotely

from a Solstice Backup client (the source client) and direct it to another Solstice

Backup client (the destination client) within an enterprise. The destination client

receiving the recovered data can be the source client itself, another Solstice Backup

client within the enterprise, or another client computer from which you are

completing the recovery.

Directed recovery:

■ Includes all of the Solstice Backup standard file-handling features.

■ Is useful in recovering data from a shared server or other computer where users

cannot recover the data themselves.

■ Allows you to perform the recovery remotely—from your own computer—rather

than from the source computer.

■ Permits recovered data to be directed to Solstice Backup client computers other

than the requesting one. This allows the sharing of files and information among a

broad range of Solstice Backup client computers.

You can use the Solstice Backup software to administer directed recoveries between

UNIX®-based and Microsoft Windows-based Solstice Backup clients by entering

Solstice Backup commands at the command line. For information about these

commands, refer to the recover(1m) man page. The nwrecover program does not

support directed recovery.

You can perform directed recoveries of data between different combinations of

Microsoft Windows-based and UNIX-based source and destination clients. You

must, however, have established the proper remote access requirements for the

clients and the Solstice Backup server that backs up their data. The source and

destination clients must also be of the same type (either both Microsoft Windows-

based, or both UNIX-based).

In this Solstice Backup release, the save stream format is different from the format in

previous releases. Therefore, you cannot use an earlier Solstice Backup release to

recover data that was backed up using the current Solstice Backup release.

Legato License Manager

The Legato License Manager is not supported with Solstice Backup.
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Resource Allocation Protocol (RAP) Size

Restriction Removed

You can now make resource values, such as directives and archive annotations,

larger than 1 KB and store larger amounts of data in single RAP values. For upgrade

considerations, see “Administering Solstice Backup 6.x Servers from Earlier Clients” on

page 28.

Fixed Bugs

TABLE 1 contains descriptions of bugs fixed in this release of the Solstice Backup

software.

TABLE 1 Fixed Bugs

Number Bug Description

LGTpa10409 When an unmount operation failed, there was no indication to the

calling function, so no error information was logged. This problem has

been resolved.

LGTpa15642 The nsrexecd -p option did not relocate save and savefs . The

state of the jukebox inventory is now updating correctly and the

nsrjb command is running normally. This problem has been

resolved.

LGTpa15841 The nsrjb -H (reset) option was running longer than usual. This was

because the state of the jukebox inventory was not updating correctly

when drives were unloaded. This problem has been resolved.

LGTpa16005 The online Help description of Force Incremental attribute needed

clarification. Additional information is now available.

LGTpa16060 The cleaning tape usage count was falling below 0, causing the backup

to wait for a cleaning tape, and then fail. This problem has been

resolved.

LGTpa17452 The “pending tape request” message was not clearing after a “stop

group” command was issued for the group with which the message

was associated. This problem has been resolved.

LGTpa17909 When the Solstice Backup service was taken off line, the /nsr
symbolic link was not being removed and correctly redefined, causing

an error the next time the Solstice Backup service was started. The

symbolic link removal and definition have been modified to include

force options. This problem has been resolved.
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LGTpa18285 The nsrmmd command failed to relinquish a volume after a media

error. This problem has been resolved.

LGTpa18388 The number of tape cleanings was being reset erroneously to its

original value after a hardware reset. This problem has been resolved.

LGTpa18404 During a certain sequence of port configurations and View Details

settings, the nsrd daemon was dumping core. This problem has been

resolved.

LGTpa18494 An error message was received from the Legato GEMS software,

because the license table was out of sync. This problem has been

resolved.

LGTpa18821 The mminfo command did not previously report save set and volume

recycle dates. This problem has been resolved.

LGTpa19175 When a client was defined using specific save sets rather than

selecting All, and if the number of save sets was large, the savegrp
command reported that the backup was successful, although some

save sets had not actually been backed up. This problem has been

resolved.

LGTpa19210,

LGTpa19534

The nsrd command was dumping core due to a message timing

problem. This problem has been resolved.

LGTpa19961 The Solstice Backup software was unnecessarily labeling blank tapes

in the jukebox under certain circumstances. This problem has been

resolved.

LGTpa20020 The error message “mminfo: media database is not
responding ” occurred when using the sapclone -s option from

the client in order to clone SAP save sets. This happened because the

mminfo command was not using the server name correctly to query

the media database. This problem has been resolved.

LGTpa20094 If an NFS client initiated a recall of previously migrated files, and then

encountered a requested file with a corrupted (inaccessible) index

entry, the /stackfs filesystem could become inaccessible. All recalls

started from other NFS clients or a Solstice Backup server could then

fail without showing an error message, and NFS could hang. At the

same time, enough lines could be written to the daemon.log file to

fill the filesystem. This problem has been resolved.

LGTpa20133 Users were not being notified about certain unresolved clients that

were not being backed up. The clients were being dropped from the

savegrp notification if any another client failed. On skip days, no

backup failure would occur, and the following error message would

be generated: “hostname resolution failed for X
client(s) ”. This problem has been resolved.

TABLE 1 Fixed Bugs (Continued)

Number Bug Description
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LGTpa20829 Index merging at the end of backing up a filesystem using NDMP was

taking a long time. This problem has been resolved; nsrdmpix has

been optimized.

LGTpa20920 A device that was restricted to a particular pool would wait for a

volume to which to write, and if it happened to find another device

that had “auto media management” set (and contained a writable

volume), it would write to it. This problem has been resolved. Device

restriction now checks the pool name before mounting and cloning a

new volume.

LGTpa20948 Directory names that contained the “)” character were not being

included in save sets. This problem has been resolved.

LGTpa21332 A request was received that popup lists of clients in the GUI be

limited to clients that can be browsed from the host on which the GUI

client is running. This request has been implemented.

LGTpa21691 Tapes belonging to a pool that should not have been allowed to use a

particular drive were nevertheless being inserted into that drive and

overwritten. The Solstice Backup software now checks a volume’s

pool restrictions before writing to it. This problem has been resolved.

LGTpa21703 The file owner and group were not being listed in the recover listing

of backed up files. This was the result of a typographical error in the

directive. This problem has been resolved.

LGTpa21778 The Legato NetWorker Module for Oracle and Sun Storage Manager

were re-setting user IDs that had been changed by Oracle code,

causing permissions problems during backups. This problem has been

resolved.

LGTpa21940 The 64-bit device driver for the HP SureStore 160ex Optical Jukebox

had not been packaged for Sun Solaris™. This problem has been

resolved.

LGTpa22093 A request to have manual command line or GUI operations logged in

daemon.log has been implemented.

LGTpa22460 The savegrp command was not backing up files in the bootstrap

backup set if the files were symbolic links. This problem has been

resolved.

LGTpa22594 The 3590E jukebox device was not supported on the HP-UX platform.

This problem has been resolved.

LGTpa23559

LGTpa24279

Nondestructive NDMP recoveries were failing with permission errors

when more than one client resource was on the same host. This

problem has been resolved.

TABLE 1 Fixed Bugs (Continued)

Number Bug Description
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Installation and Upgrade Notes

This section includes topics relevant to installing and upgrading the Solstice Backup

software.

Changes Resulting from the Improved Save

Stream File Format

A new save stream file format has been implemented in this release. The new format

makes possible many of the enhancements and new features, such as NDMP, large

save sets, and the new media database.

LGTpa23800 The ADIC Emass Grau DAS Silo was not previously supported. It is

now supported, although not currently on the AIX and HP-UX

platforms.

LGTpa23816 A jukebox cleaned its drive each time a tape was mounted, because

the Date Last Cleaned attribute of the device resource was not being

updated. This problem has been resolved.

LGTpa24649 The savefs command was not correctly reading the list of configured

ports, and selected the default port setting instead. This problem has

been resolved.

LGTpa24871 When you performed an NDMP recovery on a physically write-

protected tape, an error message appeared. To continue the recovery,

the tab would have been moved to write mode. This problem has been

resolved.

LGTpa24907 With a NetApp filer, if more than one save set was backed up

simultaneously through the Client resource, you might not have been

able to recover one of the save sets. This problem has been resolved.

LGTpa25542 Erroneous records might be improperly created in the media database.

The Solstice Backup release 6.0 software purges these error-prone

records. The problem has been resolved in Solstice Backup release

6.0.x. A utility is available from Sun Technical Support to identify and

correct the problem in release 6.0.

TABLE 1 Fixed Bugs (Continued)

Number Bug Description
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Because the new format is significantly different, some backward incompatibility

will result if you mix Solstice Backup 6.x clients or servers with pre-6.x Solstice

Backup clients or servers. Limitations encountered as a result of the new file format

can be resolved by upgrading to the Solstice Backup 6.x client and server software.

This section describes areas in which a file format mismatch would be evident.

Continued Save Sets Eliminated

The new, 64-bit format eliminates the need for continued save sets when saving data.

To use the larger save sets, the clients and servers must both be running the Solstice

Backup 6.x software. As a result of this change, the Save Set Cutoff value in the

Server resource is no longer used unless the client software is earlier than the

Solstice Backup 6.x release. A value in this field is ignored if you are backing up a

Solstice Backup 6.x client.

Save Set Names Longer Than 64 Bytes

With this release, the 64-byte size limitation on save set name lengths has been

removed. You can now create save set names up to 255 bytes long. To use the longer

names, the clients and servers must both be running the Solstice Backup 6.x
software.

Saving and Recovering between Different Releases

Using the new save stream format, you can easily recover data saved in either the

Solstice Backup 5.x or 6.x format. The format change is transparent to you unless

you have data saved in the new format and try to recover it using the earlier format.

The earlier format is unable to recover the more recent format.

TABLE 2 lists the possible combinations and their results.

TABLE 2 Save Stream Matches and Mismatches

Saved From and To Recovered By
Recovery
Successful?

6.x client to 6.x server or storage node 6.x client Yes

6.x client to 5.x server or storage node 6.x client Yes

5.x client to 6.x server or storage node 6.x client Yes

5.x client to 5.x server or storage node 6.x client Yes

6.x client to 6.x server or storage node 5.x client No
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You might receive the following error message:

under either of the following conditions:

■ An attempt is made to recover files backed up by the Solstice Backup 6.x software

using Solstice Backup 5.x software, and the new save stream format is not

recognized by a 5.x client.

■ The parallelism value is set too high, causing the recovery session to fail.

To solve this problem, do any of the following:

■ Upgrade the client from Solstice Backup 5.x software to Solstice Backup 6.x
software.

■ Recover the file to a client that has Solstice Backup 6.x software installed.

■ Decrease the parallelism value setting in the Client or Server resource. This

should improve recovery performance.

Cross-Release Tape Volumes

Once a Solstice Backup 6.x server or storage node is used to write a tape volume,

that volume can no longer be read by the server or storage node from an earlier

release. This includes labeling operations, as well as writing save sets. There is no

problem when pre-6.x volumes are read by pre-6.x storage nodes, even when the

server controlling the node is running release 6.x (a common situation if, for

example, a storage node has its own jukebox). A volume that has been written by a

Solstice Backup 6.x server or storage node, however, cannot be used by a pre-6.x
storage node.

The restriction also applies to a shared jukebox configuration, where tape volumes

might readily be read by any host (server or storage node) connected to the jukebox.

To avoid the problem, once the server—or any storage node connected to a 6.x
server—in the configuration is upgraded to the Solstice Backup 6.x software,

upgrade all components to the Solstice Backup 6.x software.

5.x client to 6.x server or storage node 5.x client Yes

6.x client to 5.x server or storage node 5.x client Yes

5.x client to 5.x server or storage node 5.x client Yes

recover failed:Error receiving files from NSR server '<server>'

TABLE 2 Save Stream Matches and Mismatches

Saved From and To Recovered By
Recovery
Successful?
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All servers and storage nodes running the Solstice Backup 6.x software can read

from, and append to, tape volumes from all releases of Solstice Backup software.

Upgrading Storage Nodes

Storage nodes running this release will not work with servers running earlier

releases. You should upgrade servers before upgrading storage nodes.

Administering Solstice Backup 6.x Servers from

Earlier Clients

With this release, you can create Solstice Backup resources (such as directives and

archive annotations) with Resource Allocation Protocol (RAP) values that are larger

than 1 KB. The 1-KB size limitation has been removed. Clients running the Solstice

Backup 5.5.x administration program, however, do not support resource values

larger than 1 KB. Consequently, to use the larger resource values, clients and servers

must both be running Solstice Backup 6.x software. Once the server contains

resource values larger than 1 KB, it is important that all administration programs be

upgraded.

Backup and recovery operations are not affected by this incompatibility. Only

administration programs are affected.

The Update Enabler Code

If you have an enabler code for an earlier release of the Solstice Backup product and

are installing this Solstice Backup release as an update, you received an update

enabler code. You need not remove the original enabler code from your Solstice

Backup server in order to enter the update enabler code.

After entering the update enabler code, register and authorize it, according to the

instructions in the Solstice Backup 6.0 Administrator’s Guide.

Known Limitations

This section describes known limitations, configuration tips, and workarounds in

this release of Solstice Backup software.



New in This Release 29

Limitations in Platform Support

This section describes platform-related limitations.

The nsrmmd Daemon Drops All Save Connections
Simultaneously on HP-UX (LGTpa12605)

When using Solstice Backup 5.5.x or 6.x on HP-UX, release 11.x, you might encounter

the following situation: during a large backup, the nsrmmd daemon drops all the

save connections simultaneously. This situation is generally limited to earlier models

of HP-UX computers. (The problem was seen on some earlier D-class s800 servers

with HP-IB interface cards. Later s800 servers with HSC/GSC/PCI cards do not

exhibit the problem.)

To prevent this situation from recurring:

1. Enter the following command to create a noreadv file in the /nsr/debug
directory:

# touch /nsr/debug/noreadv

2. Enter the following command to stop and then restart the Solstice Backup

daemons for the change to take effect:

# nsr_shutdown

# /sbin/init.d/networker start

Issue with Mounting Clone Devices on Linux and Solaris

If you perform cloning with the nwadmin GUI on Linux or in the Solaris operating

environment, a core dump results from the following workflow:

When you begin the cloning operation, you open the Save Set Clone and the Save

Set Clone Status windows. If the clone medium is unmounted when you click Start

to launch the actual cloning operation, nwadmin shows a “media waiting” event.

Closing the two “child” windows—Save Set Clone and Save Set Clone Status—

before mounting the clone device in the “parent” nwadmin GUI (by clicking on the

Mount button) causes a core dump, even though the clone operation is successful.

To prevent this, implement either of the following two solutions:

■ Ensure that your devices are ready before launching the clone operation.

■ Leave the Save Set Clone and the Save Set Clone Status windows open while

mounting the device.
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Optical Disk Restriction on AIX (LGTpa21747)

If you are running the Solstice Backup software under AIX 4.3.2 and attempt to

perform a backup using either an IBM® 3995 or HP-C1160 optical library that spans

more than one volume, the backup operation will fail after the first volume is filled.

Online Help Restriction on AIX (LGTpa21975)

When using the Solstice Backup client software on AIX, the online Help is currently

inaccessible through the usual method. If you cannot access the online help, set the

language environment variable manually before running the nwadmin program:

Using the jbconfig Command with Sun StorEdge RAID
Manager

When Sun StorEdge™ disk arrays are used in conjunction with the Sun StorEdge

RAID Manager, the inquire program may take an unexpectedly long time to

complete. The jbconfig command uses the inquire program to obtain

information about autochangers that are attached to the system.

One possible workaround for this problem is to stop the RAID Manager daemons

before running jbconfig . One disadvantage of this workaround is that RAID

Manager features, such as disk failover protection, are not operational during this

period. However, jbconfig is usually run only during installation and initial

configuration of the Solstice Backup software, and subsequently when adding

autochanger hardware to the system. Often these tasks are performed during

scheduled system maintenance periods when shutdown of the RAID Manager

software is acceptable. If you want the jbconfig program to complete rapidly, then

it is best to use jbconfig during scheduled system maintenance periods after

stopping the RAID Manager daemons.

Another possible workaround for this problem is to allow the jbconfig command

to execute with the RAID Manager daemons still running. If this method is used,

jbconfig may take a long time to complete, and this may cause unacceptable

system performance issues.

hostname> setenv LANG C

hostname> nwadmin
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Limitations in Feature Support

This section describes feature-related limitations.

Querying the Media Database from Earlier Solstice Backup
Clients (LGTpa22115)

This release introduces save set names and client names that are unique across

Solstice Backup servers. If you are using a Solstice Backup client and Solstice Backup

server running the current release, the mminfo program output displays these

unique client names as:

Release 5.x and earlier Solstice Backup clients are unable to display the cross-server

name information in an easy-to-read format. Consequently, if you run the mminfo
program from a 5.x or earlier client, specifying a Solstice Backup server that runs the

current release, an example of the unique client name output displayed is:

While this string of characters properly identifies the client name to the Solstice

Backup server, it is not easy to read. To avoid this problem, upgrade the Solstice

Backup client to the current release.

Unsupported Products

Sun does not support the following products found on the NetWorker Application

Modules CD-ROM, included in your media kit:

■ Legato NetWorker Module for EMC Symmetrix for SAP R/3 on Oracle

■ Legato NetWorker Module for EMC Symmetrix for Oracle

For more information about these products, contact Legato Systems at

sbu-sales@legato.com.

Cross-Platform Browsing of SYSTEM Save Sets (LGTpa17537)

At this time, cross-platform browsing of SYSTEM (SYSTEM STATE and SYSTEM DB)

save sets is not supported.

index:<clientname>

index:dbe4e3d0-00000004-3957b0d5-3957b0d4-00010000-8945081f.
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Two-Tape Recoveries Using a Stand-alone Tape Device
(LGTpa25779)

If you configure a tape device as a stand-alone device for a backup that spans more

than one tape, then you must load the first tape in the tape device before you can

recover data from that backup. If you start a recovery operation with the second tape

loaded in the tape device, the recovery will fail.

If you configure a tape device as a jukebox, rather than as a stand-alone device, this

problem does not occur. This problem is seen only in 64-bit operating systems.

Directed Recovery across Networks

When you attempt a directed recovery from a client on one network to a client on

another network, the recovery might fail with the following message being

displayed:

RPC error,unknown host

To complete a directed recovery from a client on one network to a client on a

different network, you must edit the Server Network Interface attribute in the Client

Setup GUI of the source client.

To edit the attribute:

1. In the nwadmin GUI , select Client Setup>Client for the source client.

2. Select View>Details.

3. Remove the name of the server of the Source Client from the Server Network

Interface attribute. Leave the attribute blank.

4. Complete the directed recovery.

Caution – After you have completed the directed recovery, you must replace the

server name in the Server Network Interface attribute of the Source Client. If you

leave this attribute blank, you will not be able to complete standard backups and

recoveries on the network.
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Client Backups Timing Out Due to the Inactivity Timeout
Feature (LGTpa23831)

The inactivity timeout feature causes a client backup to be abandoned after the

period of time designated. The default value of 30 minutes can significantly increase

the number of client backups that time out in a large-scale network environment. If

you find these errors being persistent, first ensure that your net or sub-net is not

overly congested.

To avoid too many timeouts, do one of the following:

■ Set the inactivity timeout value to 0, which disables the feature. Disabling this

feature has the side effect of causing the savegrp command to hang if a client

fails to respond, and it will require manual intervention to shut down the

savegrp session.

■ Increase the value to reflect the time necessary for the client to respond. If you

want to use the inactivity timeout feature, you should carefully consider and test

the value to avoid too many timeouts.

To change the inactivity timeout value:

1. In the nwadmin GUI, select Manage Groups>Groups.

2. Select a group to edit.

3. In the General tab of the Edit Group Default window, change the Inactivity

Timeout value.

Browse Time in Command Line for Linux and Sequent
(LGTpa22367)

In this release, Change>Browse Time does not function in the nwrecover GUI,

either for entering a date by hand or making a selection. The workaround is to use

the command line to set the browse time with the -T option before launching

nwrecover , or to use recover from the command line.

Character Limitation in Volume Browse (LGTpa24879)

In this release, if you specify a volume name that is longer than approximately 15

characters, the volume name is truncated in the Volume Browse window. Due to this

truncation, you will not be able to determine the number of the volume when

viewing the name in the Volume Browse window.
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ADIC Emass Grau DAS Silo Not Currently Supported on AIX
or HP-UX (LGTpa25307, 25602)

The Solstice Backup client and storage node software does not support the ADIC

Emass Grau DAS silo on AIX or HP-UX at this time.

Only US-ASCII 7-Bit Characters Supported (LGTpa24483)

This release supports only US-ASCII 7-bit characters in resource names and

attributes. Do not use multi-byte characters, such as Chinese or Japanese, or Roman-

language characters that include non-US markings (for example, accents or

umlauts), to complete attribute fields such as Schedule, Group, or Storage Node. All

resource names and attributes must use US-ASCII 7-bit characters.

You may, however, use multi-byte language characters or Roman-language

characters with non-US markings as filenames. For further information regarding

alphanumeric characters that can be used in Solstice Backup field names, refer to the

Solstice Backup 6.0 Administrator’s Guide.

NDMP Limitations

The feature description “Solstice Backup NDMP” on page 9 includes information

about NDMP-related limitations in this release.

Configuration Tips

This section describes configuration tips.

Modifying the maxdsiz Parameter in HP-UX to
Accommodate Large Backups

On an HP-UX system where you are installing the Solstice Backup client software,

verify that the Process Maximum Heap Limit parameter for the kernel (maxdsiz ) is

large enough to accommodate backups of one million files or more. You do this by

changing the maxdsiz parameter to 2 GB using the sam utility.

To change the maxdsiz parameter:

1. As root, run the sam utility.

2. Select the Kernel Configuration option.
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3. Select Configurable Parameters.

4. Select the maxdsiz parameter.

5. Change the value of the maxdsiz parameter to 2 GB.

6. Recompile and reboot the kernel.

Important Notes and Tips

This section contains important notes and tips on using Solstice Backup software.

Partitioning Recommended for Large Backups

It is strongly recommended that you partition larger backups, depending upon the

capacity of your tapes and your recovery speed. Partitioning larger backups allows

you to recover data in less time and lessens the risk of backups failing.

Reclaim Index Space Feature

Index enhancements in this release have made it unnecessary to reclaim unused

index space manually. Consequently, the Reclaim Index Space feature is no longer

supported in the current Solstice Backup release, although its buttons are still

present in the Solaris interface. You may ignore them.

Inactivity Timeout Feature

For information about client backups timing out due to this feature, see “Client

Backups Timing Out Due to the Inactivity Timeout Feature (LGTpa23831)” on page 33.
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NDMP User Name and Password Consideration

If you define multiple of a client, all of the instances must share a single NDMP user

name. All of the instances must share a single NDMP password, as well. (The user

name and user password should not be the same, however). If you use more than

one user name, more than one password, or a blank for any instance, you will not be

able to recover the data.

Display of Server and Client Counts in Solstice

Backup Registration Information

In the nwadmin Registration window, the base enabler displays either the number of

clients or servers, depending on the type of enabler used:

■ If you have a bulk enabler, the quantity displayed is the number of servers.

■ If you have a single enabler, the quantity displayed is the number of clients.

For UNIX platforms, the main nwadmin window also displays the number of clients,

regardless whether the enabler is single or bulk. (For the Power Edition, which

includes two cluster clients, this number will be two more than the number of

normal clients.) In this window, “Turbo” is the name displayed for WorkGroup and

Network Edition base enablers; “Extended” is displayed for Power Edition base

enablers.

Authorizing Solstice Backup Software

To obtain Authorization codes for your Solstice Backup products, contact the Sun

License Center using one of the following methods:

■ World Wide Web: http://www.sun.com/licensing

■ E-mail: license@Sun.com

■ Voice: 1-801-431-1595

■ Fax: 1-801-431-3657

If you lose your enabler code, you can request another via e-mail at:

lost-license@sun.com.

Because Solstice Backup licensing is based on the host ID, an affidavit of migration

must be obtained in order to move the Solstice Backup server to another machine.

An affidavit of migration can be requested from the Sun License Center at the

locations listed above. Once the affidavit is completed, the license center will issue a

new Authorization code.
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Note – The Solstice Backup 6.0 Roadmap (part number 806-5609-10) incorrectly

mentions purchasing an enabler certificate on page 32. This is not correct. You are

required to obtain—not purchase—Authorization codes as explained above.

Documentation Errata

This section updates your Solstice Backup documentation. The page numbers in the

headings refer to a location in the original documentation.

Solstice Backup 6.0 Administrator’s Guide

The following sections contain corrections to the Solstice Backup 6.0 Administrator’s
Guide, part number 806-5607-10.

Save Set Recovery (page 230)

The note on this page states:

Note – To perform a save set recovery, you must be listed as an administrator in the

Solstice Backup server’s resource, or your hostname or user@hostname must be

entered in the Solstice Backup client resource’s Remote Access attribute of the client

that is providing the backed up data.

The text in this note should be replaced with the following:

Note – Only root@networkerserver has the permission to perform a save set

recovery and, in the case of a remote client, root@networkerserver must be

entered in the Remote Access list of the client that provides the backed-up data.

The example that follows illustrates how to complete Remote Access entry correctly.

Example: Save Set Recovery

If a machine named saturn is being backed up by the Solstice Backup UNIX server

jupiter , you must do the following to perform a save set recovery on saturn :
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1. Log in as “root” on the server jupiter.

2. Start the Solstice Backup Administrator program and connect to the server

jupiter.

3. Select Client>Client Setup for the client saturn . Make sure that the Remote

Access attribute contains an entry for root@jupiter .

4. Complete the instructions in “To Recover Data from a Save Set” in Chapter 7 of

the Solstice Backup 6.0 Administrator’s Guide.

Important Notes on Swap Space (page 343)

The last sentence in the first paragraph of this section states:

Backups and retrievals fail if there is an adequate amount of swap space.

This sentence should state:

Backups and retrievals fail if there is an inadequate amount of swap space.

Solstice Backup 6.0 Installation Guide

The following section replaces pages 28 to 41 in the Solstice Backup 6.0 Installation
Guide, part number 806-5610-11.

Installation Requirements for a Sun
Cluster Environment

The following sections discuss the software and hardware requirements for setting

up Solstice Backup software as a high availability application in a Sun Cluster

environment:

■ “Software Requirements” on page 39

■ “Hardware Requirements” on page 39

■ “System Information Requirements” on page 39

For the most up-to-date information regarding software and hardware requirements,

refer to the Legato Compatibility Guide (www.legato.com).
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Software Requirements

To install a Solstice Backup cluster server, make sure that the following software is

installed on each node in the cluster:

■ SunOSTM

■ Sun Cluster and Logical Volume Manager

■ Solstice Backup version 6.0

■ Software listed in Installation Requirements in the Solstice Backup 6.0 Installation
Guide.

Hardware Requirements

To install the Solstice Backup software, make sure that the following hardware

requirements are met for each node in the cluster:

■ Hardware requirements listed in Installation Requirements in the Solstice Backup
6.0 Installation Guide.

System Information Requirements

FIGURE 3 and TABLE 3 display the system information needed to install the Solstice

Backup cluster server.
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Different platforms use different terms for the same cluster concepts. Sun Cluster

refers to:

■ Physical hosts as nodes

■ Virtual server as a logical host

An agent is the same as a data service.

FIGURE 3 Sample Cluster Configuration

The cluster server’s /nsr directory (/logical_host_name/nsr) must

contain sufficient space for the Solstice Backup virtual server to operate. The

logical host must have sufficient space within its disk group(s)—as illustrated in

FIGURE 3—to contain /logical_host_name/nsr .
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Installing a Solstice Backup Cluster-
Aware Server

To install and configure the Solstice Backup software as a high availability

application in a Sun Cluster environment, follow these procedures:

■ “To Install the Solstice Backup Software on All Cluster Nodes” on page 41

■ “To Define the Solstice Backup Server as a High Availability Application” on page 42

■ “To Define the List of Trusted Solstice Backup Servers” on page 43

■ “To Configure the Solstice Backup Cluster Server” on page 45

■ “To Configure Clients under the Solstice Backup Cluster Server” on page 45

■ “To Register Solstice Backup Licenses for Cluster Server Failover” on page 47

For detailed information about how to configure virtual hosts, or for general Sun

Cluster information, refer to the Sun Cluster 2.2 System Administration Guide.

▼ To Install the Solstice Backup Software on All

Cluster Nodes

Because the installation procedure varies little for installing servers and storage

nodes, the instructions are presented together in this section.

TABLE 3 Required Information

Information Required Example

Solstice Backup logical host with IP address in

the same subnet as the cluster nodes

clus_log1, 16.64.96.31

Solstice Backup package mount point for

virtual volume

/clus_log1

Solstice Backup cluster configuration script /usr/sbin/nsr/networker.cluster

Solstice Backup start method script /usr/sbin/nsr/networker.start

Solstice Backup stop method script /usr/sbin/nsr/networker.stop

Solstice Backup fault method start script /usr/sbin/nsr/networker.fm_start

Solstice Backup fault method stop script /usr/sbin/nsr/networker.fm_stop
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Note – You must install the Solstice Backup Software locally on each node in the

cluster.

1. Log in as root on the system where you want to install the Solstice Backup

software.

Change directories to the location of the Solstice Backup software distribution

files. For installation from a local or remote CD-ROM, mount the Solstice Backup

CD and then change directories to where it is mounted.

For more information, see one of the following sections of the Solstice Backup 6.0

Installation Guide:

■ To Access Installation Files From a Local CD-ROM.

■ To Access Installation Files From a Remote CD-ROM.

2. To start the installation, enter the following command at the system prompt:

3. When the following system prompt is displayed, enter the name of the logical

host:

▼ To Define the Solstice Backup Server as a High

Availability Application

To define the Solstice Backup software as a high availability application, you must

run the networker.cluster script (located in the /usr/sbin/nsr directory)

on each node within the cluster.

Caution – Configure the node mastering the logical host last.

Note – You can also use the Cluster Console GUI to run the configuration

simultaneously on all cluster nodes.

1. Log in as root.

# pkgadd -d .

# Enter the first NetWorker Server’s name [no more]
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2. Make sure that the /etc/hosts file on each cluster node contains the name of

the virtual host.

3. Run the cluster configuration script, /usr/sbin/nsr/networker.cluster
on each node in the cluster that will run the Solstice Backup server process. For

more information, see the Solstice Backup Cluster Script in the Solstice Backup 6.0
Installation Guide.

Note – If you make mistakes during this configuration step, you can undo any

configuration by using the -r option from the root directory.

a. On each node, you are prompted for the location of the local Solstice Backup

database directory provided during the installation procedure. If it is not /nsr ,

/nsr will be a symbolic link to this directory.

b. In response to the networker.cluster script prompt, enter the name for the

virtual host.

c. On the node that currently masters the virtual host, the configuration script

prompts for confirmation that all the cluster nodes have been configured.

– Answer yes  after all nodes have been configured.

or

– Answer no  to get the hareg  commands that are required once the cluster has

been fully configured.

▼ To Define the List of Trusted Solstice Backup

Servers

To define the list of trusted Solstice Backup servers:

1. On one node in the cluster, shutdown the Solstice Backup service using the cluster

management software.

2. On a node in the cluster:

a. Edit or create the /nsr/res/servers file.

b. Add the set of Solstice Backup servers, one per line, that you want to grant

access to this client. The client in this case is the physical node on which you

are defining the list of trusted Backup servers.

# hareg -n networker
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Note – Make sure that the first entry in this file is the virtual hostname for the

Solstice Backup service. This entry becomes the default Solstice Backup server.

c. Check the Solstice Backup boot-time startup file for nsrexecd -s arguments.

If they exist, delete the -s arguments. The nsrexecd -s argument supercedes

the /nsr/res/servers file.

For example, delete the arguments for nsrexecd -s in the file shown below:

# vi /etc/init.d/networker

nsrexecd -s venus -s mars

The nsrexecd daemon named in the file should appear only as:

nsrexecd

d. Use the Solstice Backup boot-time startup file to stop and restart the Solstice

Backup software. For example:

# /etc/init.d/networker stop

# /etc/init.d/networker start

Note – After you have completed defining the list of Trusted Solstice Backup

Servers, you must select one node in the cluster to create a second instance of the

default servers file. You must start the logical host to create the second instance of

the /nsr/res/servers file. This creates a link pointing to the shared disk. The following

steps explains this process.

3. On one node in the cluster, start the Solstice Backup service using the cluster

management software.

4. On the node that is running the Solstice Backup server:

a. Edit or create the /nsr/res/servers file and add the set of Solstice Backup

servers, one per line, that you want to grant access to this client.

b. Make sure that the first entry in this file is the virtual hostname for the Solstice

Backup service. This entry becomes the default Solstice Backup server.

c. Shut down and restart the Solstice Backup service using the cluster

management software.
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▼ To Configure the Solstice Backup Cluster Server

After you install and configure the Solstice Backup software as a high availability

application, you must configure the Solstice Backup server.

1. Log in to the cluster node that masters the Solstice Backup virtual server.

2. Modify the server resource:

a. Open the Solstice Backup nwadmin GUI Server window.

b. From the main menu, select Server>Server Setup.

c. In the Administrator attribute, add any cluster nodes that are not already

listed.

d. Click Add and select Apply to apply your changes.

▼ To Configure Clients under the Solstice Backup

Cluster Server

When you install the Solstice Backup 6.0 software on a cluster node, the installation

program creates the /nsr link to point to a local disk. It also creates a second link

to the local Solstice Backup directory named nsr.Backup .local. For example, if the

local Solstice Backup directory was created in /var/nsr , each client node has the

following links:

■ /nsr->/nsr.Backup.local

■ /nsr.Backup.local->/var/nsr

To make the cluster node a client of the Solstice Backup cluster server:

1. Make each physical node within the cluster a Solstice Backup client of the virtual

Solstice Backup server:

a. Using the nwadmin GUI, select Clients> Client Setup.

b. Click Create and enter the name of the physical host in the Name field.

c. Complete the remaining fields in the Client window.

d. Repeat steps a-c for each physical node in the cluster.

2. Make each virtual host within the cluster a Solstice Backup client of the virtual

Solstice Backup server:

a. Using the nwadmin GUI, select Clients> Client Setup.

b. Click Create and enter the name of the virtual server in the Name field.
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c. In the Remote Access field, enter the user@hostname of each physical node

within the cluster. For example:

root@clust_phy1

d. Complete the remaining fields in the Client window.

e. Repeat steps a-d for each virtual node in the cluster.

3. Define save groups as required.

a. Open the Solstice Backup nwadmin GUI Server window.

b. Select Customize>Groups from the main menu.

c. Select View>Details from the main menu.

d. Click Create to create a new save group. Complete the appropriate fields.

e. For each save group, click Enabled in the Autorestart field.

f. For each save group, make sure that the Manual Restart option is unchecked in

the Options field.

Caution – The only save sets that will be restarted after a virtual client or Solstice

Backup server failover are those that belong to a save group where the Autorestart

attribute is enabled and the Manual Restart option is disabled.

4. Change the server’s save set value from All to another value, such as the shared

filesystems associated with the Solstice Backup virtual host (refer to the

appropriate file in /etc/opt/SUNWcluster/conf/hanfs ).

Note – To restrict the set of Solstice Backup servers that can back up a particular

client, edit the /nsr/res/servers file and add the Solstice Backup virtual host as

well as each cluster node to the list of servers.

5. Verify that the client and group resources have been properly configured by

running a test probe. On the node on which the Solstice Backup server resides,

run the following command:

6. If the test probe does not display the scheduled back ups and index you had

wanted, you can complete one of the following:

■ Reconfigure the cluster.

# savegrp -pv -c client_name group_name
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or

■ Enter the following command to bypass the default ownership scheduling

rules:

# touch networker_bin_dir/pathownerignore

This command allows any paths to be scheduled for backups for a Solstice

Backup client.

Note – A Solstice Backup scheduled save might use a client index name other than

the one you want it to. To override this default, run a manual save with the -c
option or run the following command as a cron job. For example:

After the list of trusted Solstice Backup servers has been defined:

■ The Solstice Backup cluster server uses the IP address of the Solstice Backup

virtual host regardless of which cluster node currently masters the Solstice

Backup virtual server.

■ The Solstice Backup cluster server takes the identity of the Solstice Backup virtual

server’s hostname regardless of which cluster node is currently running the

Solstice Backup service.

■ The first time Solstice Backup software runs, it creates the client resource for the

Solstice Backup virtual host. Client resources must be created manually for any

cluster node to be backed up by the Solstice Backup virtual host.

▼ To Register Solstice Backup Licenses for Cluster

Server Failover

1. Make sure that you have already defined the Solstice Backup virtual server as

part of a cluster.

2. Make sure that the Solstice Backup service is running.

3. Log on to the system running the Solstice Backup virtual server.

4. Create a file named /nsr/res/hostids that contains the hostids of all the

cluster nodes, using the following syntax: hostid1:hostid2:hostid3:...

For example:

12345678:87654321

# save -c desired_client_name
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5. Run the hostid command on each cluster node to find the hostid values.

6. Restart the server by taking the virtual server offline and then putting it back

online. For example:

7. Register the Solstice Backup software. For details, refer to the Solstice Backup 6.0
Installation Guide.

Customer Service will then send you your authorization codes using your composite
hostid. Your composite hostid was created after step 4.

Installing Only the Solstice Backup
Client Software

To install a Solstice Backup cluster client, follow these procedures:

■ “To Install the Solstice Backup Cluster Client Software” on page 48

■ “To Configure Solstice Backup Client Software as Cluster-Aware” on page 49

■ “To Define the List of Trusted Solstice Backup Servers” on page 49

■ “To Configure the Clients under the Solstice Backup Server” on page 51

▼ To Install the Solstice Backup Cluster Client

Software

1. Log in as root on the system where you want to install the Solstice Backup

software.

Change directories to the location of the Solstice Backup software distribution

files. For installation from a local or remote CD-ROM, mount the Solstice Backup

CD and then change directories to where it is mounted.

% hareg -n networker

% hareg -y networker
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For more information, see one of the following sections of the Solstice Backup 6.0
Installation Guide:

■ To Access Installation Files From a Local CD-ROM

■ To Access Installation Files From a Remote CD-ROM

2. “To start the installation, enter the following command at the system prompt:

3. Make sure that the following steps have been performed:

a. Install the client software on every node in the cluster that you want to back

up.

b. Configure both physical and virtual client resources.

▼ To Configure Solstice Backup Client Software as

Cluster-Aware

To define the Solstice Backup application as a cluster-aware application, run the

networker.cluster script (located in the /usr/sbin/nsr directory)
on each physical host within the cluster.

1. Log in as root.

2. Make sure that the /etc/hosts file on each cluster node contains the name of

the virtual host. You can also publish the virtual hostname in DNS or NIS.

▼ To Define the List of Trusted Solstice Backup

Servers

To define the list of trusted Solstice Backup servers:

1. On one node in the cluster, shutdown the Solstice Backup service using the cluster

management software.

2. On each node in the cluster:

a. Edit or create the /nsr/res/servers file.

# pkgadd -d SUNWsbuc SUNWsbum

# hareg -n networker
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b. Add the set of Solstice Backup servers, one per line, that you want to grant

access to this client.

Note – Make sure that the first entry in this file is the virtual hostname for the

Solstice Backup service. This entry becomes the default Solstice Backup server.

c. Check the Solstice Backup boot-time startup file for nsrexecd -s arguments.

If they exist, delete the -s arguments. The nsrexecd -s argument supercedes

the /nsr/res/servers file.

For example, delete the arguments for nsrexecd -s in the file shown below:

# vi /etc/init.d/networker

nsrexecd -s venus -s mars

The nsrexecd daemon named in the file should appear only as:

nsrexecd

d. Use the Solstice Backup boot-time startup file to stop and restart the Solstice

Backup software. For example:

# /etc/init.d/networker stop

# /etc/init.d/networker start

Note – After you have completed defining the list of Trusted Solstice Backup

Servers, you must select one node in the cluster to create a second instance of the

default servers file. You must start the logical host to create the second instance of

the /nsr/res/servers file. This creates a link pointing to the shared disk. The following

steps explains this process.

3. On one node in the cluster, start the Solstice Backup service using the cluster

management software.

4. On the node that is running the Solstice Backup server:

a. Edit or create the /nsr/res/servers file and add the set of Solstice Backup

servers, one per line, that you want to grant access to this client.

b. Make sure that the first entry in this file is the virtual hostname for the Solstice

Backup service. This entry becomes the default Solstice Backup server.

c. Shut down and restart the Solstice Backup service using the cluster

management software.
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▼ To Configure the Clients under the Solstice

Backup Server

Note – The Solstice Backup server might reside outside of the cluster.

To configure the Solstice Backup server:

1. Log in to the cluster node that is running the Solstice Backup server.

2. Make each physical node within the cluster a client of the Solstice Backup server.

For each physical node:

a. Using the nwadmin GUI, select Clients> Client Setup.

b. Click Create and enter the name of the physical host in the Name field.

c. Complete the remaining fields in the Client window.

3. Make each virtual host within the cluster a client of the Solstice Backup server:

a. Using the nwadmin GUI, select Clients> Client Setup.

b. Click Create and enter the name of the Solstice Backup server in the Name

field.

c. In the Remote Access field, enter the user@hostname of each physical node

within the cluster. For example:

root@clust_phy1

d. Complete the remaining fields in the Client window.

e. Repeat steps a-d for each virtual node in the cluster.

4. Define save groups as required.

a. Open the Solstice Backup nwadmin GUI Server window.

b. Select Customize>Groups from the main menu.

c. Select View>Details from the main menu.

d. Click Create to create a new save group. Complete the appropriate fields.

e. For each save group, click Enabled in the Autorestart field.

f. For each save group, make sure that the Manual Restart option is unchecked in

the Options field.
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Caution – The only save sets that will be restarted after a virtual client failover are

those that belong to a save group where the Autorestart attribute is enabled and the

Manual Restart option is disabled.

5. Change the server’s save set value from All to another value, such as the shared

filesystems associated with the Solstice Backup virtual host (refer to the

appropriate file in /etc/opt/SUNWcluster/conf/hanfs ).

6. Verify that the client and group resources have been properly configured by

running a test probe. On the node on which the Solstice Backup server resides,

run the following command:

If the test probe does not display the scheduled back ups and index you had

wanted, you can complete one of the following:

■ Reconfigure the cluster.

or

■ Enter the following command to bypass the default ownership scheduling

rules:

# touch networker_bin_dir/pathownerignore

This command allows any paths to be scheduled for back ups for a Solstice

Backup client.

Note – A Solstice Backup scheduled save might use a client index name other than

the one you want it to. To override this default, run a manual save with the -c
option or run the following command as a cron job. For example:

Note – To restrict the set of Solstice Backup servers that can back up a particular

client, edit the /nsr/res/servers file and add the Solstice Backup host to the list

of servers.

# savegrp -pv -c client_name group_name

# save -c desired_client_name
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